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1

Product Overview

About the Remote Console Switch Software
The Dell™ Remote Console Switch Software is a cross-platform management application that 
allows you to view and control the Dell 2161DS-2/4161DS Remote Console Switch and all 
attached servers. The cross-platform design ensures compatibility with most popular operating 
systems and hardware platforms. The Remote Console Switch Software provides secure switch-
based authentication, data transfers, and username/password storage. Each switch handles 
authentication and access control individually for more decentralized system control.

The Remote Console Switch Software utilizes Explorer-like navigation with an intuitive split-
screen interface, providing you with a single point of access for your entire system. From here, 
you can manage your existing switches, install a new switch or launch a video session to a system 
server. Built-in groupings such as Servers, Sites, and Folders provide an easy way to select the 
units to view. Powerful search and sort capabilities allow you to easily find any unit.

Features and Benefits

Easy to Install and Configure
The Remote Console Switch Software is designed for easy installation and operation. Auto-
discovery of managed switches enables you to install new units in minutes. Wizard-based 
installation and online help simplify initial system configuration. The intuitive graphical 
interface makes managing and updating switches simple and straightforward.

Powerful Customization Capabilities
Tailor the Remote Console Switch Software to fit your specific system needs. Take advantage of 
built-in groups or create your own. Customize unit and field names, icons, and macros for 
maximum flexibility and convenience. Using names that are meaningful to you makes it easy to 
quickly find any system unit.
Product Overview 7



w
w

w
.d

e
ll

.c
o

m
 |

 s
u

p
p

o
rt

.d
e

ll
.c

o
m
 Extensive Remote Console Switch Management

The Remote Console Switch Software allows you to add and manage multiple switches in one 
system. Once a new switch is installed, you can configure switch parameters, control and 
preempt user video sessions, and execute numerous control functions, such as rebooting and 
upgrading your switch. From the intuitive Management Panel (MP), you can enable Simple 
Network Management Protocol (SNMP) traps, configure servers and tiered switches, as well as 
manage user databases.

The Remote Console Switch Software is designed to be compatible with the Dell 
OpenManage™ IT Assistant Event Viewer, allowing system administrators to consolidate system 
event reports.

Interoperability with Avocent Products
The Remote Console Switch Software can also be used to manage Avocent® A1000R and 
A2000R Remote Console Switches allowing increased flexibility in the management of systems.

In addition, the Remote Console Switch Software includes support for Avocent IQ Modules 
(AVRIQ’s), expanding the range of server types that can be managed. The addition of support 
for Avocent AVRIQ’s means that the following connections are now supported:

• PS/2 (Dell Server Interface Pod (SIP) and Avocent AVRIQ)

• USB (Dell SIP and Avocent AVRIQ)

• Serial (Avocent AVRIQ)

• Sun (Avocent AVRIQ)

 NOTE: Dell SIPs are not supported on Avocent A1000R and A2000R Remote Console Switches.
8 Product Overview



2

Installation

Getting Started
Before installing your Dell™ Remote Console Switch Software, refer to the following lists to 
ensure that you have all the items that shipped with your software as well as all other items 
necessary for proper installation.

Supplied with the Remote Console Switch Software
Your Dell 2161DS-2/4161DS Console Switch package contains the following items:

• Dell Remote Console Switch User Documentation and Remote Console Switch 
Software CD 

• Remote Console Switch Software User's Guide (on CD) 

• Remote Console Switch Installation Instructions 

• Download Instructions

• Safety Booklet

Supported Operating Systems
The Remote Console Switch Software is supported on the following operating systems:

• Microsoft® Windows® 2000 Workstation Service Pack 4

• Microsoft Windows 2000 Server Service Pack 4

• Microsoft Windows XP (Home and Professional) Service Pack 2

• Microsoft Windows Server 2003 Service Pack 1

• Red Hat Enterprise Linux 3.0 WS

• Red Hat Enterprise Linux 4.0 WS

• SuSE Linux Enterprise Server 8

• SuSE Linux Enterprise Server 9

• SuSE Linux 9.2

• SuSE Linux 9.3
Installation 9
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 System Hardware Configuration Requirements

The following list contains the hardware configuration requirements for running the Remote 
Console Switch Software on the supported operating systems. Configurations with less than the 
recommended requirements are not supported.

• 500 MHz Intel® Pentium® III

• 256 MB of RAM

• 10 or 100BaseT NIC (100 recommended)

• XGA Video with graphics accelerator

• Desktop size must be a minimum of 800 x 600

• Color palette must be a minimum of 65,536 (16-bit) colors

Supported Browsers
The Remote Console Switch Software is supported with the following browsers: 

• Microsoft Internet Explorer 5.0 or higher

• Netscape Navigator 6.0 or higher

• Mozilla 1.4 or higher

• Firefox 1.0 or higher

Installing the Remote Console Switch Software
The Remote Console Switch Software can be installed on Windows 2000, Windows 2003 
Server, Windows XP and Linux platforms. Follow these instructions to install Remote Console 
Switch Software on the desired platform.

To install on Windows 2000, 2003, or XP: 

1 Insert the Remote Console Switch Software CD-ROM into your CD-ROM drive. If 
AutoPlay is supported and enabled, the setup program will start automatically.
-or-
If your system does not support AutoPlay, set the default drive to your CD-ROM drive 
letter and execute the following command to start the install program (replace drive with 
your CD-ROM drive letter):

drive:\WIN32\SETUP.EXE.

2 Follow the on-screen instructions.
10 Installation



To install on Linux:

1 Insert the Remote Console Switch Software CD-ROM into your CD-ROM drive.

2 If AutoMount is supported and enabled, proceed to step 3.
-or-
If your system does not support AutoMount:

Mount the CD-ROM volume by executing the following command:

mount -t iso9660 -ro mode=0555 <device> <mount point>

Replace device with the name of the CD-ROM on your machine and mount point with the 
name of the desired mount point. For example, to mount a CD-ROM which is the second 
IDE unit on /mnt, execute the command:

mount -t iso9660 -ro mode=0555 /dev/hdb /mnt

3 At the command line, execute the following command to change the working directory to 
the mount point:

cd /mnt

4 Execute the following command to start the install program:

sh ./linux/setup.bin

Follow the on-screen instructions.
Installation 11
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3

Basic Operation

Launching the Remote Console Switch Software
To launch the Dell™ Remote Console Switch Software on all Microsoft® Windows® systems:

Select Start - Programs - Dell Remote Console Switch Software. Remote Console Switch 
Software will launch.

To launch the Remote Console Switch Software on Linux:

From the application folder (/usr/lib/Dell_Remote_Console_Switch_Software by default), enter 
the following command:

./Dell_Remote_Console_Switch_Software 

-or-

From (/user/bin), enter the following link:

./Dell_Remote_Console_Switch_Software 

-or-

If the product was installed in a directory other than the default, then execute the following 
command from a shell:

<path>/Dell_Remote_Console_Switch_Software

-or-

If a desktop shortcut was created on installation, double-click the shortcut.

The Remote Console Switch Software will launch.

Navigating the Remote Console Switch Software
The Remote Console Switch Software consists of several components: the Remote Console 
Switch Software Explorer (Explorer), the Video Session Viewer (Viewer), and the Management 
Panel (MP). Once you launch Remote Console Switch Software, the Explorer window appears. 
The Explorer window allows you to view, access, manage, and create custom groupings for all 
the supported units in your data center.

When you select a server, you can click the Connect Video task button in the Explorer to 
launch the Viewer. This component allows you to control the keyboard, monitor, and mouse 
functions of individual servers. For more information, see “Accessing and Managing Your 
Servers” on page 24.
Basic Operation 13
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 When you select a Remote Console Switch, you can click the Manage Remote Console Switch 

task button in the Explorer to launch the MP. This component enables you to control each 
individual Remote Console Switch. For more information, see “Managing Your Remote Console 
Switch” on page 57.

Viewing Your System in the Explorer
The Explorer is divided into several panes: the View Selector tabs, the Group Selector pane, and 
the Unit Selector pane. The content of these panes will change based on the type of unit 
selected or the task you wish to complete. Figure 3-1 highlights these navigation features.

Click one of the View Selector tabs to view your system organized by categories: Remote 
Console Switches, Servers, Sites or Folders. The Explorer's default display is user-configurable. 
You can have it automatically open to any one of these four tabs. For more information, see 
“Customizing the Explorer Window” on page 54. If you do not customize the default display, 
the Explorer will open to the Server view once you have added your first Remote Console 
Switch.

Explorer Window Features

Figure 3-1. Explorer Window

A Menu bar: Allows you to access many of the features in the Remote Console Switch 
Software.

B View Selector tabs: Contains four View Selector tabs for choosing the Explorer view.
14 Basic Operation



C Group Selector pane: Contains a tree view representing the groups that are available 
for the current View Selector tab. The selected group controls what is displayed in the 
Unit Selector pane when the Remote Console Switches, Sites or Folder tabs are 
selected.

D Status bar: Displays the number of units shown in the Unit list.

E Unit Selector pane: Contains the Search bar, Unit list, and Task buttons appropriate 
for the selected view or group.

F Search bar: Allows you to search the database based on the text entered in the search 
box.

G Unit list: Displays a Unit list of units contained in the currently selected group, or the 
results of the search executed from the Search bar.

H Task buttons: Contains buttons representing tasks that can be executed. Some buttons 
are dynamic based on the type of unit(s) selected in the Unit list while other buttons 
are fixed and always present.

Remote Console Switch Quick Setup Checklist
The following list is an overview of the steps you will follow to set up and configure your Remote 
Console Switch system. Each of these steps is explained in detail in separate topics throughout 
the Remote Console Switch Hardware and OSCAR® User’s Guide and Remote Console Switch 
Software User's Guide.

 NOTE: The Remote Console Switch Software can be used to manage Avocent® A1000R and A2000R 
Remote Console Switches. Therefore, all procedures outlined in this document refer to both Remote 
Console Switch and Avocent Remote Console Switches. Exceptions are noted where applicable.

 NOTE: Please ensure that all your Remote Console Switches have been upgraded to the most recent 
version of the firmware. For information on upgrading Remote Console Switch firmware see “Upgrading 
Firmware” on page 73.

To set up the Remote Console Switch: (See the Remote Console Switch Hardware and 
OSCAR® User's Guide)

1 Adjust mouse acceleration on each server to Slow or None.

2 Install the Remote Console Switch hardware, connect a Server Interface Pod (SIP) or 
Avocent® AVRIQ to each server or tiered switch. Connect each SIP or Avocent AVRIQ to 
the Remote Console Switch with CAT 5 cabling and connect the keyboard, monitor, and 
mouse connectors to the analog port of the Remote Console Switch. 

3 Connect a terminal to the configuration (serial) port on the back panel of the Remote 
Console Switch and set up network configuration (set network speed and address type). 
The IP address can be set here or from the Remote Console Switch Software. Dell 
recommends using a static IP address for ease of configuration.
Basic Operation 15
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 4 Using the local port configuration, input all server names via the On-Screen Configuration 

and Activity Reporting interface (OSCAR®).

 NOTE: For 2161DS-2 and 4161DS Console Switches, names can be modified from the Servers category 
or the MP. For more information, see “Modifying a Server Name” on page 69.

To set up the Remote Console Switch Software: (See the Installation section of this guide.)

1 Install the Remote Console Switch Software on each client workstation. 

2 From one client workstation, launch the Remote Console Switch Software. 

3 Click the New Remote Console Switch task button to add the new switch to the Remote 
Console Switch Software database. If you configured the IP address as described above, 
select Yes, the product already has an IP address, otherwise select No, the product does 
not have an IP address. Remote Console Switch Software will find the Remote Console 
Switch and all SIPs attached to it. These names display in the Explorer. 

 NOTE: In addition to adding and managing Dell Remote Console Switches using the Remote Console 
Switch Software, you can also add and manage Avocent® A1000R and A2000R switches.

4 Set properties and group servers as desired into locations, sites or folders through the 
Explorer. 

5 Create user accounts through the MP.

6 Once one client workstation is set up, select File - Database - Save to save a copy of the 
database with all the settings.

7 From the second client workstation, click File - Database - Load and browse to find the file 
you have saved. Select the file and click Load.

8 If the local user (via OSCAR®) adds, deletes or renames any SIPs after you have loaded 
this file, you can resynchronize your local database with OSCAR® by clicking the Manage 
Remote Console Switch task button and clicking the Resync button under the Settings - 
Server tab.

9 To control an attached server select it, in the Explorer, and click the Connect Video task 
button to launch a server session in the Viewer.

10 Adjust the resolution (select View - Manual Scale) and quality (select Tools - Manual 
Video Adjust) of the server video in the Viewer.

Adding a Remote Console Switch or Avocent Remote Console 
Switch
In addition to the Dell Remote Console Switch, the Remote Console Switch Software can also 
be used to manage Avocent® A1000R and A2000R Remote Console Switches. Therefore, as part 
of the process of adding a Remote Console Switch to your Remote Console Switch Software 
database, you will be prompted to select the vendor and product type for the switch you want 
to add.
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Before you can access a unit through the Remote Console Switch, you must add it to the 
Remote Console Switch Software database. Once a Remote Console Switch or Avocent Remote 
Console Switch is added, it appears in the Unit list. You may either manually add or discover a 
Remote Console Switch.

To add a new Remote Console Switch with an assigned IP address:

1 Select File - New - Remote Console Switch from the Explorer menu. 
-or-
Click the New Remote Console Switch task button. The New Remote Console Switch 
Wizard appears.

2 Click Next to continue. The Product Type dialog box appears and prompts you to select 
the Remote Console Switch vendor and product.

Figure 3-2. Product Type Dialog Box

3 Select a Vendor. For each vendor, the supported product names appear in the Product list. 
Select a product.

 NOTE: In Figure 3-3, a 2161DS Console Switch has been selected. Each dialog box in the New Remote 
Console Switch Wizard indicates the type of switch you have selected from the Product list.

4 Click Next.

5 You are prompted to indicate whether the Remote Console Switch has an assigned IP 
address or not. Click Yes and then click Next.

6 The Locate window appears. Type the IP address and click Next.
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 Figure 3-3. Locate Digital Dialog Box

7 The Remote Console Switch Software searches for the indicated unit as well as all the 
powered SIPs, Avocent AVRIQ’s, and server names you associated with it in OSCAR®, if 
any. If you want to search for unpowered SIPs or Avocent AVRIQs, you can access the 
Resync feature under the Servers category in the MP and click to enable the Include 
Offline SIPs check box. For more information, see “Viewing and Resynchronizing Server 
Connections” on page 67.

8 Click Next.

9 The Configure Tiered Switches dialog box appears if the Remote Console Switch Software 
detects an attached legacy switch. This dialog box contains a list of all SIP Electronic ID 
numbers (EIDs) retrieved from the Remote Console Switch and the tiered switches to 
which they are connected, if any. When this dialog box first displays, all the switches will 
be set to None. Switches detected will have an icon next to the drop-down list.

a The Existing Tiered Switches field contains a list of all the current switches defined in 
the database. Click Add, Modify, or Delete to alter the list.

b Associate the appropriate switch from the drop-down lists for each SIP or Avocent 
AVRIQ that has a switch attached.
18 Basic Operation



Figure 3-4. Configure Tiered Switches Dialog Box

10 When you reach the final page of the Remote Console Switch Wizard, click Finish to exit 
and return to the main window. Your Remote Console Switch should now appear in the 
Unit Selector pane.

To add a new Remote Console Switch that does not have an assigned IP address:

1 Select File - New - Remote Console Switch from the Explorer menu. 
-or-
Click the New Remote Console Switch task button. The New Remote Console Switch 
wizard appears.

2 Click Next to continue. The Product Type dialog box appears and prompts you to select 
the Remote Console Switch vendor and product.
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 Figure 3-5. Product Type Dialog Box

3 Select a Vendor. For each vendor, the supported product names appear in the Product list. 
Select a product and click Next.

4 You are prompted to indicate if the Remote Console Switch has an assigned IP address. 
Click No and then click Next.

5 The Network Address window appears. Type the IP address, subnet mask, and gateway you 
wish to assign to the unit and click Next.

 NOTE: The 2161DS Console Switch supports BootP (Bootstrap Protocol) and static IP addressing. Dell 
recommends that IP addresses be reserved for each unit and that they remain static while the 2161DS 
Console Switch units are connected to the network. The 2161DS Console Switch does not support 
dynamic IP address assignment or BootP emulation through DHCP. DHCP is supported for both 2161DS-2 
and 4161DS appliances.

6 The Select Remote Console Switch window appears, prompting you to select the unit to 
add from the list of new Remote Console Switches that were found. Select the product and 
then click Next.

7 The Configuring Remote Console Switch window appears to indicate whether the IP 
information was successfully configured. If the configuration was successful the Remote 
Console Switch Software will search for the new Remote Console Switch as well as all SIPs, 
AVRIQs, and server names associated with it. Click Next.
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8 The Configure Tiered Switches dialog box appears if the Remote Console Switch Software 
detects an attached legacy switch. This dialog box contains a list of all SIP and Avocent 
AVRIQ EIDs retrieved from the Remote Console Switch and the tiered switches to which 
they are connected, if any.

a The Existing Tiered Switches field contains a list of all the current switches defined in 
the database. You may add to, delete or modify the list.

b Associate the appropriate switch from the drop-down lists for each SIP that has a 
switch attached.

Figure 3-6. Configure Tiered Switches Dialog Box

9 When complete, click Finish to exit the Wizard and return to the main window. Your 
Remote Console Switch should now be in the Unit Selector pane.

To discover a Remote Console Switch:

1 Select Tools - Discover from the Explorer menu. The Discover Wizard appears. Click Next 
to continue.

2 The Address Range page appears. Type the range of IP addresses you wish to search on the 
network in the To and From boxes. Use the IP address dot notation xxx.xxx.xxx.xxx. Click 
Next to continue.

3 The Searching Network progress bar appears. Progress text indicates how many addresses 
have been probed from the total number specified by the range and the number of Remote 
Console Switches or Avocent Remote Console Switches found. If one or more new Remote 
Console Switches or Avocent Remote Console Switches are discovered, the Wizard shows 
the Select Remote Console Switches to Add page. From this page, you can choose the 
Remote Console Switches to add to the local database.
-or-
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 If no new Remote Console Switches were found (or if you clicked Stop), the Wizard will 

show the No New Remote Console Switches Found page and you will need to add the 
switch manually. For more information, see the previous procedure.

4 Click the Remote Console Switch(es) you wish to add and click the Add (>) button to 
move the selection to the Remote Console Switches to Add list.

Figure 3-7. Select Remote Console Switches to Add Dialog Box

5 Repeat step 4 for all Remote Console Switches you wish to add. Click Next to continue.

6 The Adding Remote Console Switches progress bar appears while the new switches are 
being added. Once all of the selected switches have been added to the local database, the 
Discover Wizard Completed page appears. Click Finish to exit the Wizard and return to 
the main window. Your new switches should now be in the Unit Selector pane.

7 If one or more switches could not be added to the local database for any reason (including 
if you clicked Stop during the add process), the Discover Wizard Not All Remote Console 
Switches Added page appears. This page will list all of the switches that you selected and 
the status for each. The status will indicate if a Remote Console Switch was added to the 
local database and if not, why the process failed. Click Done when you are finished 
reviewing the list.

 NOTE: If a Remote Console Switch already exists in the database with the same IP address as a 
discovered unit, then the discovered switch will be ignored and will not display on the next Wizard page.
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Accessing Your Remote Console Switch
When you click the Remote Console Switches tab, you will see a list of the switches currently 
defined in the local database. To access a Remote Console Switch, you must first log into it by 
typing a username and password. The default username is Admin (case sensitive) with no 
password. Once you have logged in to a particular Remote Console Switch, the Remote Console 
Switch Software will cache the username and password in memory for the duration of the Remote 
Console Switch Software session.

 NOTE: You can clear the login credentials an re-login under another username and password by 
selecting Tools - Clear Login Credentials.

Figure 3-8. Remote Console Switch View Tab Selected

To log into a Remote Console Switch:

1 Click the Remote Console Switches tab in the Explorer. 

2 Double-click a Remote Console Switch in the Unit Selector pane.
-or-
Select a Remote Console Switch from the Unit Selector pane, and click the Manage 
Remote Console Switch task button.
-or-
Right-click on a Remote Console Switch in the Unit Selector pane. A pop-up menu 
appears. Select Manage Remote Console Switch.
-or-
Click a Remote Console Switch in the Unit Selector pane and press <Enter>.
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 3 A login prompt appears. Type your username and password. If this is the first time you have 

accessed the Remote Console Switch or you have not assigned a username and password, 
type the default username, Admin (case sensitive), with no password.

4 Click OK to access the Remote Console Switch. This launches the MP. For more 
information about the MP, see “Managing Your Remote Console Switch” on page 57.
-or-
Click Cancel to exit without logging in.

To search for a Remote Console Switch in the system:

1 Click the Remote Console Switch tab and insert your cursor in the search text box.

2 Type the search information. This can be the Remote Console Switch name or any 
information you have entered in the other Unit Selector list headings such as Type or 
Location or IP Address.

3 Click the Search button. The results appear in the Unit list.

4 Review the results of your search.

-or-

Click the Clear Results button to display the entire list again.

To auto search by typing in the Unit list:

1 Click the Remote Console Switch tab.

2 Type the first few characters of a Remote Console Switch name. The highlight will move to 
the first Remote Console Switch beginning with those characters. If you pause for a second 
or more between letters, the function will reset itself and you can begin to type the first few 
characters of the next Remote Console Switch.

Accessing and Managing Your Servers
The Servers tab displays a list of servers defined in the database. The Group Selector pane 
appears displaying a tree view containing all of the unique server types that are defined in the 
database. The Group Selector pane only appears if two or more server types are defined. You can 
either click All Servers or click on a folder to view all the servers of a particular type. When you 
select a server and click the Connect Video task button, the Viewer launches. The Viewer allows 
you full keyboard, monitor and mouse control over a server.

You can also scan through a customized list of servers by enabling individual servers to appear in 
the Thumbnail Viewer. This view contains a series of thumbnail frames, each containing a 
small, scaled, non-interactive version of a server's screen image. For more information, see 
“Viewing Multiple Servers Using the Scan Mode” on page 35.
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Figure 3-9. Server View Tab Selected

To access a server:

1 Click the Servers tab in the Explorer.

2 Select a server to access in the Unit Selector pane.

3 Click the Connect Video task button. 
-or-
Right-click on the server. A pop-up menu appears. Select Connect Video.
-or-
Double-click the server name. 
-or-
Press <Enter>. The Viewer launches in a new window.

To search for a server in the system:

1 Click the Servers tab and insert your cursor in the search text box. 

2 Type the search information. This can be the server name or any information you have 
entered in the other Unit Selector list headings such as Type or Location. 

3 Click the Search button. The results appear in the Unit list. 

4 Review the results of your search.
-or-
Click the Clear Results button to display the entire list again. 
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 To auto search by typing in the Unit list:

1 Click the Servers tab.

2 Type the first few characters of a server name. The highlight will move to the first server 
beginning with those characters. If you pause for a second or more between letters, the 
function will reset itself and you can begin to type the first few characters of the next 
server.

Interacting With the Server Being Viewed
Once you have connected to a server, you will see the desktop window of the server on your 
screen. This opens in a separate window. You will see two cursors, the local cursor and the 
server’s cursor. You may need to align these if they do not move together or adjust the video if 
they seem to jump about. From this window, you will be able to access all the normal functions 
of this server as if you were sitting right in front of it. You may also perform Viewer-specific tasks 
such as sending special macro commands to the server.

Viewer Window Features

Figure 3-10. Viewer Window

A Menu bar: Access many of the features in the Viewer.

B Accessed server desktop: Interact with your server through this window.
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Viewer Menu bar

Figure 3-11. Viewer Menu Bar

A Thumbtack: Click to lock the menu bar in place. This prevents the menu bar from 
hiding once you have moved the mouse cursor away from the menu bar. 

B Menu Options: The menus provides access to functions available through the Viewer. 

C Toolbar Buttons: You may add up to 10 buttons to the tool bar. These buttons allow 
you to provide easy access to defined functions and keyboard macros. By default, the 
Align Local Cursor, Refresh Image, and Single Cursor Mode buttons are displayed. 

D Connection Status Indicator: The connection status indicator indicates how the user 
is connected to the appliance for this server. For more information see “Connection 
Sharing” on page 44.

Adjusting the Viewer
You can adjust the Viewer settings to match your requirements. This includes adjustment of the 
video resolution, toolbar settings, and keyboard macro settings.

Connection Status Indicator Sharing Mode

Exclusive Mode

Active Connection (normal, non-
sharing, non-exclusive session)

Active Sharing (Primary User)

Active Sharing (Secondary User)

Passive Sharing

Stealth Mode
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 Adjusting the Viewer Tool bar

You may add up to 10 buttons to the toolbar. These buttons allow you to provide easy access to 
defined function and keyboard macros. By default, the Align Local Cursor, Refresh Image, and 
Single Cursor Mode buttons are displayed. 

To add buttons to the toolbar:

1 From the Tools menu, choose Session Options. The Session Options toolbar is displayed.

2 Click the Toolbar tab.

3 Click to select the items you want to add to the Viewer toolbar.

4 Click OK to accept the changes and return to the Viewer main window.

Figure 3-12. Session Options Dialog Box - Toolbar Tab

Setting the Toolbar Hide Delay Time

Unless the Thumbtack button has been clicked, the toolbar will disappear when you remove the 
mouse cursor. You can change the interval between the removal of the mouse cursor and the 
disappearance of the toolbar by adjusting the Toolbar Hide Delay time.

To change the Toolbar Hide Delay time:

1 From the Tools menu, choose Session Options. The Session Options toolbar is displayed.

2 Click the Toolbar tab.

3 In the Toolbar Hide Delay field, type the number of seconds for which you want the 
toolbar to display, after the mouse cursor is removed.
- or - 
Using the Up and Down button, click to increase or decrease the number of seconds for 
which you want the toolbar to display, after the mouse cursor is removed.

4 Click OK to accept the change you have made and return to the Viewer main window.
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Expanding and Refreshing Your Viewer

By default, there are three buttons that display on the Viewer toolbar that allow you to adjust 
the Viewer display. The first button allows you to set the Viewer to Single Cursor Mode. This 
allows you to use the mouse in the Viewer as if it was the mouse on the server. When the Viewer 
is set to Single Cursor mode the local cursor is not displayed.

 NOTE: Single Cursor mode operates on Windows platforms only.

The second button allows you to align the mouse cursors, the third allows you to refresh the 
video. 

Figure 3-13. Viewer Toolbar- Display Adjustment Buttons

To set the Viewer to Single Cursor mode:

In the Viewer toolbar, click the Single Cursor Mode button.

To align the mouse cursors:

Click the Align Local Cursor button on the Viewer toolbar. The local cursor will align with the 
cursor on the remote server.

To refresh the screen:

Click the Refresh Image button on the Viewer toolbar. 
-or-
From the Viewer menu, select View - Refresh. The digitized video image will be completely 
regenerated.

To enter full screen mode:

Click the Maximize button in the top right-hand corner of the Viewer. 
-or-
From the Viewer menu, select View - Full Screen. The desktop window will disappear and only 
the accessed server desktop will be visible. The screen will be resized up to a maximum of 
1024x768. If the desktop has a higher resolution, then a black background will surround the full 
screen image. The floating toolbar will appear.

To exit full screen mode:

Press <Esc> to exit full screen mode and return to the desktop window.

Adjusting the Viewer Window
You can adjust both the size and quality of the server’s Viewer. You can also expand your Viewer 
to fit the entire screen or refresh the view at any time.
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 Adjusting the Viewer Resolution

If Auto Scale is enabled, the Remote Console Switch Software automatically adjusts the display 
when the Viewer window size changes during a session. When you access a channel using 
sharing, the display is adjusted to match the input resolution selected by the primary user of 
that channel. This prevents the primary user's display from being affected. If the resolution 
changes any time during a session, the display is adjusted automatically.

When Full Scale is selected, the Viewer adjusts to the screen resolution of the server and sets 
the screen size accordingly, up to a maximum resolution of 1024 x 768.

To adjust the size of the Viewer window:

From the menu bar, select View - Scaling - Auto Scale to allow the server image to be scaled 
automatically.
or
From the menu bar, select View - Scaling - Full Scale
or
Select a screen resolution from the Scaling sub-menu.

Figure 3-14. Viewer Scaling

Adjusting the Video Quality
The Viewer offers both automatic and manual video adjustment capability. Generally, the 
Automatic Video Adjustment will optimize the video for the best possible view. However, you 
may wish to alter the video for your specific needs. Use the slider bar for large adjustments and 
the Plus (+) and Minus (-) buttons are designed for fine-tuning adjustments.

Adjusting Color Depth

 NOTE: The Color command may only be used by the primary user. The command is not available to non-
primary users who are sharing the session.

 NOTE: If Background Refresh is enabled from the Session Options dialog, the color depth will be set 
automatically to Best Color Available and cannot be changed.
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The Color sub-menu allows you to set the color depths at which the digital image can be 
compressed. The 2161DS-2 and 4161DS Remote Console Switches support the Dambrackas 
Video Compression (DVC) algorithm, which enables the Remote Console Switch Software 
users to adjust the number of viewable colors in a remote session window. You may choose to 
display more colors for the best fidelity, or fewer colors to reduce the volume of data transferred 
on the network.

The Viewer window can be viewed using the Best Color Available (slower updates), Best 
Compression (fastest updates), a combination of Best Color and Best Compression or in 
Grayscale.

The color depths of individual ports and channels can be specified by selecting the View - Color 
command in a Remote Session window. These settings are saved individually per port and 
channel.

To set the color depth:

From the View menu, choose Color and select a color depth from the Color sub-menu.

To manually adjust the video quality of the Viewer window:

1 Select Tools - Manual Video Adjust. The Manual Video Adjust dialog box appears.

2 Click the icon for the feature you wish to adjust.

3 Move the slider bar or click the Minus (-) or Plus (+) buttons to adjust the parameter for 
each icon pressed. The adjustments will display immediately in the Viewer window.

4 When finished, click Close to exit the Manual Video Adjust dialog box.

Manual Video Adjust Dialog Box Options

Figure 3-15. Manual Video Adjust Dialog Box

A Image Capture Width

B Pixel Sampling Fine Adjust

C Image Capture Horizontal Position

D Image Capture Vertical Position
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 E Contrast 

F Brightness 

G Noise Threshold 

H Priority Threshold 

I Automatic Video Adjustment

J Refresh Image 

K Adjustment bar

L Video Test Pattern 

M Help button

N Performance Monitor

O Close box

Minimizing Remote Video Session Discoloration
When establishing remote video sessions, pixel discolorations may occur due to network 
conditions. This condition occurs most often with a solid color background. This condition is 
minimized by using a black background. If a color background is used, a small number of pixels 
on the screen will be discolored or white.

To minimize remote video pixel discoloration:

1 On the client system, launch the Remote Console Switch Software.

2 From the Management screen, go to Tools - Manual Video Adjust.

3 Choose contrast or brightness.

4 Incrementally, adjust the contrast and brightness until the image quality improves.

5 A noise threshold setting is also available under Tools - Manual Video Adjust for fine 
incremental adjustments.

 NOTE: Reducing the noise threshold to zero causes constant video refresh, high network usage and a 
flickering video. Dell recommends that the noise threshold be set to the highest level that allows efficient 
system performance, while still being able to recover pixel colors over which the mouse cursor travels. 

 NOTE: When adjusting the noise threshold, use the slider bar for large adjustments and the Plus (+) and 
Minus (-) buttons at the ends of the slider bar for fine-tuning.

Improving Screen Background Color Display
You may experience inconsistent color display when viewing target servers where photographic 
images or color-intense gradient backgrounds have been selected. We recommend that you 
select a solid color display background via the operating system for optimal display quality and 
performance.
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Adjusting the Mouse

The Viewer allows you to select between five different mouse cursor options, set up mouse 
scaling and resynchronize your mouse should it no longer track properly. Dell recommends 
turning off the local cursor by setting the Local Cursor option to None. This will leave only one 
cursor on the screen, the remote cursor, and will simplify navigation.

Figure 3-16. Viewer Mouse Session Options dialog box 

Setting Mouse Scaling
You can choose between three preset mouse scaling options or set your own custom scaling. The 
three preset settings are: Default (1:1), High (2:1) or Low (1:2). In a 1:1 scaling ratio, every 
mouse movement on the desktop window will send an equivalent mouse movement to the 
server. In a 2:1 scaling, the same mouse movement will send a 2X mouse movement. In a 1:2 
scaling, the value will be 1/2X.

To set custom mouse scaling:

1 Select Tools - Session Options. The Session Options dialog box appears.

2 Click the Mouse tab.

3 Click the Custom radio button. The X and Y fields become enabled.

4 Type the mouse scaling values you wish in the X and Y fields. For every mouse input, the 
mouse movements are multiplied by the respective X and Y scaling factors. Valid input 
ranges are 0.25 to 3.00.
Basic Operation 33



w
w

w
.d

e
ll

.c
o

m
 |

 s
u

p
p

o
rt

.d
e

ll
.c

o
m
 Minimizing Mouse Trailing

During a remote video session, as the mouse moves on the screen, some pixels will remain 
discolored. This condition is referred to as mouse trailing, and is due to varying levels of network 
and other noise in different environments. To minimize mouse trailing, you may need to reduce 
the Noise Threshold in the Manual Video Adjust dialog box.

To reduce the Noise Threshold:

1 Select Tools - Manual Video Adjust. The Manual Video Adjust dialog box appears.

2 Click the Noise Adjust Threshold icon for the feature you wish to adjust.

3 Using the mouse, move the slider bar to the center of the scale, and then down to zero.

4 Use the Plus (+) and Minus (-) buttons at the end of the slider bar to fine-adjust the noise 
threshold to just above zero.

 NOTE: Leaving the noise threshold at zero triggers constant video refresh, resulting in high network 
usage and a flickering video. It is recommended that the noise threshold be set at the highest level that 
allows efficient system performance, while still being able to recover pixel colors that the mouse cursor 
travels over. 

 NOTE: When adjusting the noise threshold, the slider bar is used for large adjustments and the Plus (+) 
and Minus (-) buttons at either end of the slider bar for fine-tuning.

Improving Mouse Performance
If you are experiencing slow mouse response during a remote video session, you may want to 
deactivate the mouse acceleration in the operating system of the target server.

Microsoft Windows 2000 Default Mouse Drivers:

1 Select Start - Settings - Control Panel.

2 Double-click the Mouse icon.

3 Click on the Motion tab.

4 Adjust mouse speed to the exact midpoint of the slider bar.

5 Click OK. Use the Align Local Cursor/Mouse button in the Viewer to resynchronize the 
mouse.

Microsoft Windows XP and Server 2003 Default Mouse Drivers:

1 Select Start - Settings - Control Panel.

2 Double-click the Mouse icon.

3 Click on the Pointer Options tab.

4 Adjust mouse speed to the exact midpoint of the slider bar.

5 In the Acceleration setting, select the Off radio button.

6 Click OK. Use the Align Local Cursor/Mouse button in the Viewer to resynchronize the 
mouse.
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Intellipoint Drivers (Only for Windows based Operating Systems):

1 Select Start - Settings - Control Panel.

2 Double-click the Mouse icon.

3 Cycle through the tabs until the pointer speed slider is displayed.

4 Adjust the mouse speed to the exact midpoint of the slider bar.

5 Click the Advanced button.

6 Click the Acceleration check box to turn off acceleration.

7 Click OK. Use the Align Local Cursor/Mouse button in the Viewer to resynchronize the 
mouse.

Red Hat Linux:

1 Select the Mouse settings from the Desktop Controls.

2 Set Acceleration to 1.0.

3 Apply the changes and use the Align Local Cursor/Mouse button in the Viewer to 
resynchronize the mouse.

Reducing Mouse Cursor Flickering
If the video driver on the Remote Console Switch Software client machine does not support 
DirectDraw and the DirectDraw option in the Remote Console Switch Software has been 
activated, the mouse cursor will flicker on the screen. The Remote Console Switch Software 
factory default has DirectDraw disabled. If the video driver on the client system supports 
DirectDraw and the additional performance is desired, follow the instructions below to enable 
DirectDraw.

To enable or disable DirectDraw:

1 In the Explorer window, select Tools - Options.

2 Click to enable or disable the DirectDraw check box.

3 Click OK.

4 Restart the Remote Console Switch Software.

Viewing Multiple Servers Using the Scan Mode
The Viewer allows you to simultaneously view multiple servers through the Thumbnail Viewer 
of the Scan mode. This view contains a series of thumbnail frames, each containing a small, 
scaled, non-interactive version of a server's screen image. The server name displays below each 
thumbnail as well as the status indicator.
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 Scanning Your Servers

Using the Thumbnail Viewer, you can set up a scan sequence of up to 16 servers to monitor your 
servers. The scan mode moves from one thumbnail image to the next, logging into a server and 
displaying an updated server image for a user-specified length of time (View Time Per Server), 
before logging out of that server and moving on to the next thumbnail image. You can also 
specify a scan delay between thumbnails (Time Between Servers). During the delay, you will see 
the last thumbnail image for all servers in the scan sequence, though you won't be logged into 
any servers.

An indicator light at the bottom of each frame displays the status of the server. The default 
thumbnail size is based on the number of servers in the scan list.

Figure 3-17. Viewer - Thumbnail Viewer

Scan mode is a lower priority than an active connection. If you have an interactive session with a 
server, that server will be skipped in the scan sequence and the scan mode will proceed to the 
next server. No login error messages will appear. Once the interactive session is closed, then the 
thumbnail will be included in the scan sequence again. If another user has an active connection 
to a server, the server will be skipped and a red “X” will be displayed in the indicator light below 
the frame.
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Figure 3-18. Viewer - Scanning Servers

To access the Scan mode:

1 Select the Servers, Sites or Folders tab.

2 Select two or more servers in the Unit Selector pane by pressing the <Shift> key. 
-or- 
Press the <Ctrl> key. The Scan Mode task button appears.

3 Click the Scan Mode task button. The Thumbnail Viewer window appears.

Thumbnail View Status Indicators
The green LED indicates that a server is currently being scanned. The red X indicates that the 
last scan of the server was not successful. The scan may have failed due to a credential or path 
failure (the server path on the Remote Console Switch was not available), or because of some 
other reason. When the mouse pointer is placed on the red X a tool tip appears and indicates 
the reason for the failure.

Setting up your Scanning Preferences

To set scan preferences:

1 From the Thumbnail Viewer, select Options - Preferences. The Preferences dialog box appears.

2 Enter the time each thumbnail will be active during the scan (10 to 60 seconds) in the 
View Time Per Server box. 

3 Enter the length of time the scan stops between each server (5 to 60 seconds) in the Time 
Between Servers box.

4 Click OK.
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 Navigating the Thumbnail Viewer

When you highlight an individual thumbnail frame and select the Thumbnail menu, you can 
launch an interactive session to that server, add that server to the scan sequence or set the login 
credentials for that server. The Options menu allows you to access scanning preferences as well 
as pause the scan and set the thumbnail size for all servers.

To launch a server Video session:

1 Select a server thumbnail.

2 From the Thumbnail Viewer, select Thumbnail - [server name] - View Interactive Session. 
-or-

Right-click a server thumbnail and select View Interactive Session. That server's video will 
be launched in an interactive Viewer window.

To enable or disable a server in the scan sequence:

1 Select a server thumbnail.

2 From the Thumbnail Viewer, select Thumbnail - [server name] - Enable. 
-or-

Right-click a server thumbnail and select Enable. That server will be included/excluded in 
the server thumbnail scan sequence. 

 NOTE: The Enable menu item state can be toggled from checked (enabled) to unchecked (disabled) 
each time it is selected.

 NOTE: If a server is being accessed by a user, the Enable menu will be disabled for that server 
thumbnail.

To pause or restart a scan sequence:

1 From the Thumbnail Viewer, select Options - Pause Scan. The scan sequence will pause at 
the current thumbnail if the Thumbnail Viewer has a scan in progress or will restart the 
scan if currently paused.

To change the thumbnail size:

1 From the Thumbnail Viewer, select Options - Thumbnail Size.

2 Select the desired thumbnail size from the menu.

Using Macros to Send Keystrokes to the Server
The Macros menu in the Viewer allows you an easy way to send multiple keystrokes to the 
server. The Viewer provides a list of default keystroke selections. However, you may set up your 
own macros by using the Configure option at the bottom of the Macros drop-down list as well 
as change the set that displays by default.

To send keystrokes to the server:
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Click the Macro menu in the Viewer and choose the name of the macro containing the 
keystrokes you wish to send to the server. Figure 3-19 shows the default macros that ship with 
the Remote Console Switch Software. If you do not see the name of the macro you wish, select 
Configure > Macros to access the Macros dialog box. Here you can create, modify, delete and 
copy macros.

Figure 3-19. Viewer Macro Menu Expanded

To change the default Macro group:

1 Select Macros - Configure - Macro Groups in the Viewer. The Macro Groups dialog box 
appears.

2 Select Windows or Sun from the Defined Groups list.

3 Click to select the Display on Menu check box.

4 Click Close.

Creating New Macros
You can create custom macro keystrokes as well as modify and delete existing macros through 
the Macros dialog box.

To create a new macro:

1 Select Macros - Configure - Create from the Viewer. The Macro dialog box appears.
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 Figure 3-20. Viewer Macros dialog box

2 Click Create. The Create Macro dialog box appears.

Figure 3-21. Create Macro dialog box

3 Type the name of the macro in the Macro Name field.

4 Select the keyboard layout from the Keyboard Type list.

5 Select the icon that will appear to denote the macro from the Macro Icon list.

6 Using the on-screen keyboard, type the keystrokes you wish to send in the Keystrokes field. 

7 Click OK to accept the macro and return to the Macros dialog box.
-or-
Click Reset to erase all the keystrokes entered in the Keystrokes box.
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Grouping Macros
The Macro Groups dialog box allows you to arrange macros into logical groups. Macro groups 
for Windows and Sun are already predefined. However, you can alter these groups or create an 
entirely new group. You can also rename and delete groups that have been previously created.

To create a macro group:

1 Select Macros - Configure - Macro Groups from the Viewer. The Macro Groups dialog 
box appears. 

2 Click Create. The Create Macro Group dialog box is displayed. 

Figure 3-22. Viewer Create Macro Group Dialog Box

3 Type a name. Click OK to save the name and return to the Macro Groups dialog box. A 
tab with the new name appears.

To add macros to an existing group:

1 Select Macros - Configure - Macro Groups. The Macro Groups dialog box is displayed.

2 Click to select a pre-defined macro group and click Edit. The Edit Macro Group dialog 
box is displayed.

3 Click on the macro you wish to add from the Macros Available pane on the left side of the 
dialog box. Click the Add button. The macro appears in the Macros in Group box. Use the 
Move Up and Move Down buttons to move the macro up or down.

4 Repeat step 3 until all the macros you grouped appear in the Macros In Group box.
5 Click OK to accept the macro group and return to the Macros dialog box.

-or-
Click Cancel to leave this dialog box without saving changes.
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 Session Options General Tab

The General tab in the Session Options dialog box allows you to control the Keyboard 
Passthrough option in non-full screen mode, the Menu Activation Keystroke and the 
Background Refresh selection.

The Keyboard Pass-through check box allows you to specify whether Keyboard Pass-through 
mode is enabled, or not. The Keyboard Pass-through option is not selected by default.

Figure 3-23. Session Options - General Tab

The Menu Activation Keystroke list allows you to select a keystroke that activates the toolbar. 

The Background Refresh check box allows you to specify whether background refreshing occurs. 
When this option is selected the Viewer is sent a constant stream of data from the device 
whether or not a change has occurred on the device.

Screen Capturing
The Viewer allows you to capture the contents of the screen and to save it to a file or to copy it 
to the clipboard.

To capture a screen as a file:

1 In the Viewer, choose File - Capture to File. The Save dialog is displayed.

2 Browse to the location where you want to save the file.

3 In the File Name field, type a file name and click Save.

To copy a screen to the clipboard:

In the Viewer, choose File - Capture to Clipboard. The image is saved to the clipboard and can 
be pasted into a document or image editing application.

 NOTE: The Capture to Clipboard function is not available in Linux.
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Preemption
Preemption provides a means for users with sufficient privilege to take control of a server from 
another user with lesser or equal privilege.

 NOTE: No time period will be displayed in cases where the server being viewed is attached to an 
Avocent A1000R or Avocent A2000R.

 NOTE: All users sharing the connection that is being preempted will be warned, but only the primary 
user will be able to reject the preemption (if allowed).

Table 3-1 outlines the preemption scenarios and detailed scenarios in which preemption 
requests can be rejected.

Preemption of Remote User by a Remote Administrator
If a remote administrator attempts to access a server that is being accessed by a remote user, a 
message appears asking that the administrator waits while the user is informed that they will be 
preempted. The remote user cannot reject the preemption request and will be disconnected. 
The time period given before disconnection is defined by the Video session preemption timeout 
setting in the Session dialog box. For information, see “Changing Global Network and Session 
Parameters” on page 58.

 NOTE: No time period will be displayed in cases where the server being viewed is attached to an 
Avocent A1000R or Avocent A2000R.

Table 3-1. Preemption Scenarios

Current User Preempted by Preemption can be rejected

Remote User Local User No

Remote User Remote Administrator No

Remote User Remote Console Switch Administrator No

Remote Console Switch 
Administrator

Local User Yes

Remote Console Switch 
Administrator

Remote Console Switch Administrator Yes

Remote Administrator Local User No

Remote Administrator Remote Administrator Yes

Remote Administrator Remote Console Switch Administrator No

Local User Remote Administrator Yes

Local User Remote Console Switch Administrator Yes
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 Preemption of a Local User/Remote Administrator by a Remote Administrator

If an administrator attempts to access a server that is being accessed by the local user or by 
another remote administrator with equal privileges, the currently connected user can accept or 
reject the preemption request. A message appears asking the connected local user or remote 
administrator whether they want to accept the preemption request. If the preemption request is 
rejected a message appears informing the remote administrator that their request has been 
rejected and that they cannot access the server.

 NOTE: If the server being viewed is attached to an Avocent A1000R or A2000R the user is not given the 
option to accept or reject preemption.

 NOTE: In scenarios where a preemption request can be rejected, the Session Preemption Request 
dialog box will appear. This dialog allows you to accept the preemption request by clicking the Accept 
button or to reject the preemption request by clicking the Reject button or by closing the dialog box.

Connection Sharing
Connection sharing allows multiple users to interact with a target device at the same time. 
When you are a primary user, you may be notified by a dialog box that another user would like to 
share your connection. You may select Yes to accept sharing, No to reject sharing, or click the 
Passive Share box to allow the new user to share without having any control over the connection.

When you attempt to open a video session with a device that is already being viewed by another 
user, you are notified that the device is already being viewed. Depending on the configuration of 
sharing settings, you may be offered the option to share or preempt the video session. You may 
also be offered the option to open a stealth video session.

 NOTE: Stealth video sessions are passive Video sessions, where the primary user is not aware of the 
presence of the secondary user. The ability to open a stealth video session is governed by the privilege of 
the user. If a user can preempt another user, they can also open a Stealth video session.

Access to the device is governed by the nature of the current user’s connection to the device. 
There are two types of Video Session users: a Primary user and up to 11 simultaneous Secondary 
users (a single 2161DS-2 or 4161DS appliance supports up to 12 simultaneous sessions across all 
attached servers). Only the Primary user can accept or reject preemption requests for all users 
sharing a connection. The Primary user also maintains control of video parameters and the 
display resolution of the Video session.

Secondary users may be either Active users who have the ability to input mouse and keyboard 
data, or Passive users who may not input mouse and keyboard data.

If Automatic Sharing is enabled on the Remote Console Switch, Secondary Users do not need 
the permission of the Primary User to join the session.

If a Primary user leaves the session then the oldest Secondary user with Active user privileges 
will become the Primary user. If there are no Secondary users with Active user privileges sharing 
the session when the Primary user leaves the session, then the session will be closed.

For more information about configuring connection sharing, see “Changing Global Network 
and Session Parameters” on page 58.
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Exclusive Mode

Exclusive Mode allows you to have exclusive control of a Video session. When in Exclusive 
Mode, no other user can share the session (except in Stealth mode). If other users are sharing 
the session when you select Exclusive Mode, you are warned that selecting Exclusive Mode will 
cause the other users to become disconnected from the session.

 NOTE: Only the Primary user can request an Exclusive session. If other users are sharing at the time 
Exclusive Mode is requested, they are disconnected, regardless of the Primary users access level.

To open a Video session in Exclusive mode:

In the Viewer, choose Tools - Exclusive Mode.

Changing Server Properties
You can alter individual server properties from the Properties dialog box including General, 
Network, Information, and Connections. The General tab allows you to change the server 
name, server type and the icon that will be used to display the server in the Remote Console 
Switch Software. You may also assign the server to a site, location or folder. The Network tab lets 
you set a browser URL for that server if you want to launch a browser to the server’s web server 
instead of launching a Viewer session. The Information tab allows you to enter information 
about the server including a server description, contact information and any comments you 
might wish to add. Lastly, the Connections tab displays the physical connection path that is used 
to access this server and the connection type, such as video.

 NOTE: You can also change the properties of your Remote Console Switch. For more information, see 
“Changing Remote Console Switch Properties” on page 79.

To change server properties:

1 Click the Server tab and then select an individual server in the Unit Selector list.

2 Select View - Properties from the Explorer menu.
-or-
Click the Properties task button.
-or-
Right-click the server and select Properties. The Properties dialog box appears.
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 Figure 3-24. Server General Properties tab

3 Type the name of the server. Duplicate names are not allowed.

4 (Optional) Select the server type. If the selection is not in the drop-down list, type the 
name of the new server type in the text field. Once entered, the option becomes available 
in the drop-down list for future assignment.

5 Select the icon to display for the unit.

6 (Optional) Assign a server to a site, department or location. If an option is not in the drop-
down list, type the name of the new assignment in the text field. Once entered, the option 
becomes available in the drop-down list for a future assignment.

7 (Optional) Click the Network tab and type the URL you want to use when establishing a 
browser connection to the server. If the field contains a value, then the Browser button 
appears in the task bar allowing you to launch the browser to that specified URL.
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Figure 3-25. Server Network Properties Tab

8 (Optional) Click the Information tab and type a description of the unit. You can enter any 
information in the following fields.

a In the Description field, enter 0 to 128 characters.

b In the Contact field, enter 0 to 128 characters.

c In the Contact Phone Number field, enter 0 to 64 characters.

d In the Comments field, enter 0 to 256 characters.

e Server Information Properties Tab.
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 9 Click on the Connections tab to view the connections of the server. Connections 

properties are available only for servers and are read-only. The display indicates the physical 
connection path that is used to access this device and the connection type, such as video.

10 When finished, click OK to save the new settings.
-or-
Click Cancel to exit without saving the new settings.

Accessing a Server via a Browser Window
You can configure your system to open a server connection in a browser window. You must first 
select a server and define a URL in the Properties dialog box. Then, when you select the server, 
the Browse task button appears. You can select the browser to use in the Explorer’s Options 
dialog box.

To launch the server URL in a browser window:

1 Select a server in the Unit Selector pane.

2 If you have defined a URL for this server in the Properties dialog box, the Browse task 
button appears. Click the Browse task button. The URL you identified will launch in a 
browser window.

Organizing Your System
The Sites and Folders view tabs allow you to organize and manage your Remote Console 
Switches and servers by custom groups. Site organization is based on where your servers are 
located and refers to the column headings Site and Department, which can be customized to 
suit your needs. See “Modifying Custom Field Names” on page 50. Folders are a way to create a 
customized organizational system for individual servers. For example, you might want to create 
a folder for critical servers or for remote servers.

You may change the order and sorting of the Unit Selector list by clicking in the column header. 
An upward-pointing arrow in a column header indicates that the list is sorted by that field name 
in ascending order. A downward-pointing arrow indicates the list is sorted by that field name in 
descending order.

You can customize the column headings. Figure 3-26 and Figure 3-27 show examples of how you 
might use the default field name values. You may change them to fit your own organization. 
Figure 3-28 shows an example of customized field names.
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Figure 3-26. Sites View Tab Selected

Figure 3-27. Folders View Tab Selected
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 Modifying Custom Field Names

Custom field names allow you to change the Site, Department, and Location column heading 
names that appear in the Group and Unit Selector panes. This allows you to group Remote 
Console Switches and servers in ways that are meaningful to you. The Department field is a 
subset of Site. If you customize these field names, you should keep this hierarchy in mind.

Figure 3-28. Example of Modified Custom Fields 

To modify a custom field label:

1 Select Tools - Options from the Explorer menu. The Options dialog box appears.

Figure 3-29. Options Dialog Box - Custom Field Labels

2 Select the field label you wish to modify and click the Modify button. The Modify 
Custom Field Label dialog box appears.

3 Type the singular and plural versions of the field label. The length can be from 1 to 32 
characters. A blank value is not allowed. Spaces are permitted in the middle but leading 
and trailing spaces are not allowed.

4 Click OK to save the new field label.
-or-
Click Cancel to exit without saving changes.
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To create a new site, department or location:

1 Select View - Properties from the Explorer menu. 
-or-
Click the Properties task button. The Properties dialog box appears.

2 Click the General tab and select the drop-down list for Site, Department or Location. If a 
name is not in the drop-down list, type the name you want in the text field. The name can 
be from 1 to 32 characters long. Names are not case sensitive and can consist of any 
combination of characters entered from the keyboard. Spaces are permitted in the middle 
but leading and trailing spaces are not allowed. Duplicate names are not allowed.

3 Click OK. The new site, department or location appears in the Group Selector pane.

To create a new folder:

1 Select the Folders View Selector tab.

2 Click the Folders node and select File - New - Folder. 
-or-
Right-click the Folders node and select New Folder. The New Folder dialog box appears.

3 Type a name for the folder from 1 to 32 characters long. Folder names are not case sensitive 
and can consist of any combination of characters entered from the keyboard. Spaces are 
permitted in the middle but leading and trailing spaces are not allowed. Duplicate folder 
names are not allowed at the same level but are allowed across different levels.

4 Click OK. The new folder appears in the Group Selector pane.

Assigning a Unit to a Site, Location, or Folder
You can assign a Remote Console Switch or server to a Site, Department, Location or Folder. 
This menu item is only enabled when a single Remote Console Switch or server is selected in 
the Unit Selector pane. These custom targets are defined in the General Properties dialog box.

To assign a unit to a site, location or folder:

1 Select a unit in the Unit Selector pane.

2 Select Edit - Assign from the Explorer menu.
-or-
Click the Assign To task button. 
-or-
Right-click a unit and select Assign To. The Assign To dialog box appears.
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 Figure 3-30. Assign To Dialog Box

3 Select the site, location, or folder category from the drop-down list.

4 Select the target from the list of available targets to which the unit can be assigned within 
the chosen category. This could be empty if no site, location or folder has been defined in 
the local database.

5 Click OK to save the assignment.
-or-
Click Cancel to exit without saving changes.

To drag and drop a unit into a site, department, location or folder:

1 Click and hold on a unit in the Unit list. Drag the item to the node in the tree view of the 
Group Selector pane. Release the mouse button. The item now appears in the Unit list 
when you click that node.

 NOTE: A unit cannot be moved to All Departments, All Units or the root Sites node. Units can only be 
moved one at a time.

Deleting and Renaming
The delete function is context-sensitive based on what is currently selected in the Group and 
Unit Selector panes. When you select and delete a unit in the Unit list, the unit is removed 
from the local database. When you select and delete an item in the tree view of the Group 
Selector pane, you will delete Server Types, Sites, Departments, and Folders. However, none of 
the actions result in units being deleted from the local database.

The rename function is also context-sensitive. You can select and rename a Remote Console 
Switch or a server from the Unit list. You can select and rename server types, sites, departments, 
and folder names in the tree view of the Group Selector pane.

 NOTE: If you delete or rename a server through the Remote Console Switch Software, the OSCAR® 
server list at the Console Switch becomes out of date. Re-synchronizing will not work in this instance. 
Servers should be deleted or renamed from OSCAR® and then re-synchronized in the Remote Console 
Switch Software.
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To delete a Remote Console Switch or server:

1 Select the unit(s) you wish to delete from the Unit Selector pane.

2 Select Edit - Delete.
-or-
Press the <Del> key on your keyboard. A dialog box appears confirming the number of 
units to be deleted. If you are deleting a Remote Console Switch, the dialog box includes a 
Delete Associated Servers check box. Click to enable/disable the check box as desired.

3 Click Yes to confirm the deletion. Additional message prompts may appear depending on 
your configuration. Respond as appropriate. The Remote Console Switch or server is 
deleted.
-or-
Click No to cancel.

To delete a server type, site, department or folder:

1 Select the server type, site, department or folder you wish to delete from the Group 
Selector pane.

2 Select Edit - Delete.
-or-
Press the <Del> key on your keyboard. A dialog box appears confirming the number of 
units that will be affected by this deletion.

3 Click Yes to confirm the deletion. Additional message prompts may appear depending on 
your configuration. Respond as appropriate. The element is deleted.
-or-
Click No to cancel.

To rename a unit, site, department or folder:

1 In the Group Selector pane, click on the server, site, department or folder you wish to 
rename.

2 Select Edit - Rename. The Rename dialog box appears.

3 Type a name from 1 to 32 characters long. Names are not case sensitive and can consist of 
any combination of characters entered from the keyboard. Spaces are permitted in the 
middle but leading and trailing spaces are not allowed. Duplicate names are not allowed, 
with two exceptions: department names can be duplicated across different sites and folder 
names can be duplicated across different levels.

4 Click OK to save the new name.
-or-
Click Cancel to exit without saving changes.
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 Customizing the Explorer Window

The Explorer window can be resized at any time. Each time you launch the application, the 
Explorer window opens to its default size and location. You can manually resize the window 
while the application is running, but the information is not saved. The next time Explorer is 
started, it will come up in its default size and location.

A split-pane divider that runs from top to bottom separates the Group Selector pane and the 
Unit Selector pane. You can move the divider left and right to change the viewing area of the 
Group Selector pane and the Unit Selector pane. Each time Explorer is started the divider will 
appear in its default location. See “Appendix B: Keyboard and Mouse Shortcuts” on page 85 for 
divider pane and tree view control mouse and keyboard shortcuts.

Modifying the Selected View on Startup
When Default is checked under the Selected view on startup option, the Explorer will 
determine which view to display. If you have one or more servers defined, the Servers tab will 
appear by default. If you do not, the Remote Console Switches tab will appear.

When Default is unchecked, the Explorer will display the view selected in the drop-down list 
shown below the check box. The drop-down list contains the following values: Remote Console 
Switches, Servers, Sites, and Folders. The drop-down list is only enabled when the check box is 
disabled.

To modify the selected view on startup:

1 Select Tools - Options from the Explorer menu. The Options dialog box appears.

2 Select Remote Console Switches, Servers, Sites or Folders from the drop-down list.

3 Click OK to save the new startup view.
-or-
Click Cancel to exit without saving changes.

Changing the Default Browser
You can specify which browser launches when viewing a server URL in a browser window. You 
have the option of using the default browser for your system, or you can select a specific browser 
to launch for that server.

To change the default browser:

1 Select Tools - Options from the Explorer menu. The Options dialog box appears.

2 Click to disable the Launch Default Browser check box. The Browse button is enabled.

3 Click the Browse button and navigate to the browser.

4 Click OK to save the new browser selection.
-or-
Click Cancel to exit without saving changes.
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Managing Your Local Databases
Each client workstation running the Remote Console Switch Software contains a local database 
that records the information that you enter about your units. If you have multiple client 
workstations, you may wish to configure one station and then save a copy of this database and 
load it into the other stations to avoid having to reconfigure each station. You might also wish to 
export the database for use in another application.

Saving a Database
The Remote Console Switch Software allows you to save a copy of the local database. The saved 
database can then be loaded back to the same computer where it was created, or it can be loaded 
onto another client workstation. The saved database is compressed into a single Zip file.

While the database is being saved, no other activity is allowed. All other windows including 
Video Session windows and MP windows must be closed. If other windows are open, a message 
will appear prompting you to either continue and close all open windows or quit and cancel the 
database save process.

To save a database:

1 Select File - Database - Save. The Database Save dialog box appears.

Figure 3-31. Database Save Dialog Box

2 Select a database to save.

3 Type a file name and browse to a location to save the file.

4 Click Save. A progress bar appears during the save. When finished, a message appears 
indicating that the save was successful and you are returned to the main window.
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 Exporting a Database

This function allows you to export fields from the local database to an ASCII Comma Separated 
Value file (CSV) or Tab Separated Value file (TSV). The following database fields will be exported.

Remote Console Switch Flag
Type
Name
Address
Custom Field 1
Custom Field 2
Custom Field 3
Description
Contact Name
Contact Phone #
Comments Browser URL

 NOTE: The Address field only applies to Remote Console Switches and the Browser URL field only 
applies to servers. In the exported file, the Address field data will be empty for servers and the Browser 
URL field data will be empty for Remote Console Switches.

The first line of the exported file contains the column names for the field data. Each additional 
line contains the field data for a Remote Console Switch or server. The file will contain one line 
for each Remote Console Switch and server defined in the local database.

To export a database:

1 Select File - Database - Export from the Explorer menu. The Database Export dialog box 
appears.

2 Type a file name and navigate to the location where you wish to save the exported file.

3 Select the type of export format you wish from the Files of Type drop-down list.

4 Click Export. A progress bar appears during the export. When finished, a message appears 
indicating that the export was successful and you are returned to the main window.

Loading a Database
This function allows you to load a database that was previously saved. While the database is 
being loaded, no other activity is allowed. All other windows including Video Session windows 
and Management Panel windows must be closed. If other windows are open, a message appears 
prompting you to either continue and close all open windows or quit and cancel the database 
save process.

To load a database:

1 Select File - Database - Load from the Explorer menu. The Database Load dialog box appears.

2 Browse to select the database you wish to load.

3 Click Load. A progress bar appears during the load. When finished, a message appears 
indicating that the load was successful and you are returned to the main window.
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4

Managing Your Remote Console Switch

The Management Panel
Once you have installed a new Remote Console Switch, you have the ability to view and 
configure unit parameters, determine who has access and control rights, view and control 
currently active video sessions and execute a variety of control functions such as rebooting and 
upgrading your Remote Console Switch. This is accomplished through the Management Panel 
(MP). The MP has three tabs: Settings, Status, and Tools.

 NOTE: The Dell Remote Console Switch Software can be used to manage Avocent® A1000R and A2000R 
Remote Console Switches. Therefore, all procedures outlined in this document refer to both Remote 
Console Switch and Avocent Remote Console Switches. Exceptions are noted where applicable.

To access the MP:

1 Click the Remote Console Switches tab in the Explorer.

2 Double-click a Remote Console Switch from the Unit Selector pane.
-or-
Select a Remote Console Switch from the Unit Selector pane, and then click the Manage 
Remote Console Switch task button.
-or-
Right-click a Remote Console Switch in the Unit Selector pane. A pop-up menu appears. 
Select Manage Remote Console Switch.
-or-
Click a Remote Console Switch in the Unit Selector pane and press <Enter>. A password 
prompt appears.

3 Type your username and password and click OK. The MP dialog box appears.
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 Figure 4-1. Management Panel Dialog Box

Viewing and Configuring Remote Console Switch Parameters
The Settings tab allows you to display an expandable list of categories covering a wide range of 
parameters for your Remote Console Switch. When a category is selected from the list, the 
parameters associated with the category will first be read from the unit, the database or both. 
You will then be able to modify those parameters and send the changes securely back to the 
Remote Console Switch.

Changing Global Network and Session Parameters
The Global category allows you to view the product type, serial number, and language setting for 
the Remote Console Switch. If you select the Network sub-category, you will be able to change 
the network settings including the IP address, Subnet Mask, Gateway and LAN speed. The 
Network panel also allows you to enable or disable DHCP for connections on which DHCP is 
supported.

The Sessions sub-category allows you to apply controls to your video sessions.

By enabling the Video session timeout option, you allow the Remote Console Switch to close 
an inactive video session after a specified number of minutes. The Video session preemption 
time out option allows you to specify the time (5 - 120 seconds) for which a preemption warning 
message appears before a video session is preempted. For more information about preemption, 
see “Preemption” on page 43. If this option is not enabled, preemption occurs without warning.
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The Encryption Levels option allows you to specify the type of encryption to be used for video, 
keyboard, and mouse sessions. You can select multiple methods when a new client connection is 
requested. The Remote Console Switch negotiates for the highest enabled encryption method.

The Connection Sharing options indicate which sharing options are enabled. Enable Share 
Mode, Automatic Sharing, Exclusive Connections, and Stealth Connections all appear 
checked when the particular option is enabled. Automatic Sharing, Exclusive Connections and 
Stealth Connections are enabled only when Enabled Share Mode is selected. For more 
information, see “Connection Sharing” on page 44.

The Input Control Timeout option controls the time period allowed for between inputs from 
an active session before another session gains control. The values range from 1 to 50 tenths of a 
second and the option is only available if Share Mode is selected.

 NOTE: Changes you make to session parameters affect future connection requests only, and not 
existing connections.

Figure 4-2. Global Sessions Dialog Box - 2161DS-2 Console Switch

 NOTE: Preemption timeout, Video Encryption or Connection Sharing settings cannot be configured for 
Avocent A1000R and A2000R Remote Console Switches.
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 Setting Up User Accounts

When you select the Users category for the first time, the MP will retrieve and display a list of 
usernames and current access levels from the Remote Console Switch. You can add, modify or 
delete users in this listing. You can assign three access levels: User, Administrator, and Remote 
Console Switch Administrator. The User access level allows you to assign individual server 
access rights to a user.

Users can become locked out by the Security Lock-out feature if they try to enter an invalid 
password five consecutive times. You can configure Security Lock-out settings as well as unlock 
any user through the Users category.

 NOTE: Preemptions listed in Table 4-1 only apply to Remote Clients. They do not apply to users 
accessing the server locally.

Table 4-1. User Access Level Rights

Operations Remote Console 
Switch Administrator

Administrator User

Preemption All Equal and lesser No

Configure network & global settings 
(security mode, time-out, Simple 
Network Management Protocol (SNMP))

Yes No No

Reboot Yes No No

FLASH upgrade Yes No No

Administer User Accounts Yes Yes No

Monitor server status Yes Yes No

Target Device Access Yes Yes Assigned by Admin
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Figure 4-3. Users Dialog Box

To add or modify a user:

1 Click the Users category in the left column of the MP.

2 Click the Add button on the right side of the window to add a new user. The Add User 
dialog box appears. 
-or- 
Select a user and click the Modify button to modify a current user. The Modify User 
dialog box appears.

Figure 4-4. Add User Dialog Box

3 Type the username and password you wish to assign to the user and then verify the 
password by typing it in the Verify Password field.

4 Select the appropriate access level you wish for this user from the drop-down list. If you 
select the User option, the Access Rights button becomes active.
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 a Click the Access Rights button to select individual servers for that user. The User 

Access Rights dialog box appears.

Figure 4-5. User Access Rights Dialog Box 

b Select a server in the left column for which this user should have access rights. Click 
Add.

c Select a server in the right column from which you wish to remove the user’s access 
rights. Click the Remove button.

d Repeat steps a and b until the right column represents the appropriate server access for 
this user, and then click OK.

5 Click OK to save the settings and return to the main MP window.

To change the user password:

1 Select the Users category in the left column in the MP.

2 Select one user from the list and click the Modify button. The Modify User dialog 
appears.

3 Type the password for that user in the Password box and then repeat the password in the 
Verify Password box. The password must be between 5 and 16 characters long and contain 
both alpha and numeric characters of both upper and lower case.

4 Click OK to return to the MP.

5 Click Apply or OK to send the updated password to the appliance.

To delete a user:

1 Click the Users category in the left column of the MP and then select the user(s) you wish 
to delete.

2 Click the Delete button on the right side of the MP Users window. A confirmation window 
appears.

3 Click Yes to confirm the deletion.
-or-
Click No to exit the window without deleting the user.
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Locking and Unlocking User Accounts
If a user enters an invalid password five consecutive times, the Security Lock-Out feature will 
temporarily disable that account. If a user attempts to log in again, the software client 
application displays an appropriate error message.

 NOTE: All accounts (user, administrator, and remote console switch administrator) are subject to this 
lock-out policy.

A remote console switch administrator can specify the number of hours (1 to 99) that accounts 
will remain locked. When Enable Lock-outs is unchecked, the security lock-out feature will be 
disabled and no users will be locked out.

If an account becomes locked, it will remain locked until the duration time has elapsed, the 
remote console switch is power-cycled or an administrator unlocks the account via the MP. An 
Administrator may unlock only user accounts, whereas a Remote Console Switch Administrator 
may unlock any type of account.

To unlock an account:

1 Select the Users category in the MP.

2 Select the user to unlock.

3 Click the Unlock button. The lock icon next to the username will disappear.

4 Click OK or Apply. This allows the user to log in again.
-or-
Click Cancel to exit without saving.

To specify the length of time a user account remains locked:

1 Click the Users category in the MP.

2 Click to enable the Enable Lock-outs check box.

3 Type the number of hours that a user will be locked out (1 to 99).

To disable the Security Lockout feature:

1 Select the Users category in the MP.

2 Click the Enable Lock-outs check box. The Duration field is disabled.

 NOTE: Disabling Security Lock-out will have no affect on users that are already locked out.

Viewing the SIPs and Avocent AVRIQs
The Server Interface Pods (SIPs) category lets you view the SIPs and Avocent AVRIQs in your 
system, their port and Electronic ID number (EID) as well as the computer type and keyboard 
layout.

You can also view the SIP status. A green circle indicates that the SIP is online. A yellow circle 
indicates the SIP is being upgraded and a red X indicates that the SIP is offline. To clear offline 
SIPs click Clear Offline and click OK when prompted.
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 The Language button displays the Language dialog, in which you can set language and keyboard 

parameters for all the Sun/USB SIPs of the whole appliance.

 NOTE: The Clear Offline button is not displayed when managing Avocent A1000R and A2000R Remote 
Console Switches.

 NOTE: It is not possible to clear Offline SIPs or Avocent AVRIQs that are attached to a tiered analog 
Console Switch.

 NOTE: This operation will clear all offline SIPs on the Remote Console Switch, including those 
associated with any powered down Servers.

 NOTE: User access rights will also be updated to remove the Servers associated with the cleared offline 
SIPs.

Figure 4-6. SIPs Dialog Box - 2161DS-2 Console Switch

 NOTE: The Remote Console Switch supports Avocent AVRIQs as well as Dell SIPs. Therefore, although 
Dell SIPs are available with PS/2 and USB connections, the addition of Avocent AVRIQs provides support 
for Sun and Serial connections.

 NOTE: To determine if an item identified as PS2 or USB is a Dell SIP or an Avocent AVRIQ, access the 
SIPs Versions panel. For more information see “SIPs Subcategory” on page 71.
64 Managing Your Remote Console Switch



Enabling and Configuring SNMP 
SNMP is a protocol used to communicate management information between network 
management applications and Remote Console Switches. Other SNMP managers can 
communicate with your Remote Console Switch by accessing MIB-II and the public portion of 
the enterprise MIB. When you select the SNMP category for the first time, the MP will retrieve 
the SNMP parameters from the unit.

In this dialog box, you can enter system information and community strings. You may also 
designate which stations can manage the Remote Console Switch as well as receive SNMP traps 
from the switch. For more information on traps, see “Enabling Individual SNMP traps” on 
page 66 in this chapter. If you check Enable SNMP, the unit will respond to SNMP requests over 
UDP port 161.

 NOTE: The MP does not use standard SNMP to control switches and therefore does not use UDP 
port 161. The MP uses a secure, proprietary protocol to communicate with the Remote Console Switches 
over a different network port. For more information, see “Appendix C: Ports Used by Console Switch 
Software” on page 87.

Figure 4-7. SNMP Configuration Dialog Box

To configure general SNMP settings:

1 Select the SNMP category in the left column in the MP.

2 Click to enable the Enable SNMP check box to allow the Remote Console Switch to 
respond to SNMP requests over UDP port 161.
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 3 Type the system’s fully qualified domain name in the Name field, as well as a node contact 

person in the System section.

4 Type the Read, Write, and Trap community names. These specify the community strings 
that must be used in SNMP actions. The Read and Write strings only apply to SNMP over 
UDP port 161 and act as passwords that protect access to the Remote Console Switch. The 
values can be up to 64 characters in length.

5 Add up to four management workstations that are allowed to manage this Remote Console 
Switch or leave this blank to allow any station to manage the Remote Console Switch.

a Click Add to define an allowable manager. The Allowable Manager dialog box 
appears.

b Type the IP address of the management station that you wish to add.

c Click OK to add a management station.

6 Add up to four management workstations to which this Remote Console Switch will send 
traps in the Trap Destination field.

a Click Add to define a trap destination. The Trap Destination dialog box appears.

b Type the IP address of the trap destination that you wish to add.

c Click OK to add a trap destination.

7 Click OK to save the settings and close the window.
-or-
Click Apply to save the settings and remain in the open window.
-or-
Click Cancel to exit the window without saving.

Enabling Individual SNMP traps
An SNMP trap is a notification sent by the Remote Console Switch to a management station 
indicating that an event has occurred in the Remote Console Switch that may require further 
attention. The Dell OpenManageTM IT Assistant software is the event manager. You can specify 
what SNMP traps are sent to the management stations by simply clicking the appropriate check 
boxes in the list. When you select the Traps category for the first time, the MP will retrieve and 
display a list of SNMP traps from the Remote Console Switch. You can select Enable All or 
Disable All to easily select or deselect the entire list.
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Figure 4-8. Traps Dialog Box

Viewing and Resynchronizing Server Connections
When you select the Servers category for the first time, the MP will retrieve the servers that 
exist in the Remote Console Switch Software database as well as information on how the servers 
are connected to the selected Remote Console Switch.

The Connection column displays the current server connection. This can be to either a SIP or a 
tiered switch. If connected to a SIP, the SIP’s EID will display in the Connection column. If 
connected to a tiered switch, the switch and all of its channels will be displayed. If no unit is 
currently connected to the path, then this field will display as None. If you click either a SIP or 
switch in the Connection column, the Viewer will launch.
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 Figure 4-9. Servers Dialog Box

Resynchronizing the Server Listing
You may wish to periodically resynchronize the database on your client workstation with the 
database stored in the Remote Console Switch. Do this if the local user has changed server 
names or if SIPs have been added or moved.

 NOTE: This procedure only re-synchronizes your own client workstation. If you have multiple client 
workstations, you may wish to save your re-synchronized local database and load it into the other client 
workstations to ensure consistency.

To resynchronize the server listing:

1 Click the Resync button in the Server category of the MP. The Resync Wizard launches. 
Click Next. A warning message displays indicating that the database will be updated to 
match the current configuration in the Remote Console Switch. Your current local 
database names will be overridden with the switch names. To include unpowered SIPs or 
Avocent AVRIQs in the re-synchronization, click to enable the Include Offline SIPs check 
box.

2 Click Next. A polling Remote Console Switch message box appears with a progress bar 
indicating that the switch information is being retrieved.
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3 If no changes were detected in the appliance, a completion dialog box appears with this 
information. 
-or-
If server changes were detected, then the Detected Changes dialog box will be displayed. 
Click Next to update the database.

4 If a cascade switch was detected, the Enter Tiered Switch Information dialog box appears. 
Select the type of switch connected to the appliance from the drop-down list. If the type 
you are looking for is not available, you can add it by clicking the Add button. For more 
information, see “Viewing and Configuring Tiered Switch Connections” on page 70.

5 Click Next. The completion dialog box appears.

6 Click Finish to exit.

Modifying a Server Name
The Modify button in the Servers dialog allows you to rename a selected server. The dialog box 
allows you to change a server name from a remote workstation rather than from the OSCAR of 
the Remote Console Switch.

To modify a device name:

1 In the Server category, click to select the server whose name you wish to change.

2 Click Modify. The Name Modify dialog is displayed.

Figure 4-10. Name Modify Dialog Box

3 Type the name you want to assign to the server.

4 Click OK. The name you have supplied is updated in both the remote console switch and 
local client database.
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 Viewing and Configuring Tiered Switch Connections

The Tiered Switches category lets you view the tiered switches in your system, the SIP EID 
numbers as well as the type of switch it is.

To configure a cascade switch connection:

1 Select the Tiered Switches category in the left hand column in the MP.

2 Click the Switch drop-down list next to the SIP EID you want to configure and select the 
switch type you want to assign.
-or-
If the switch you want is not in the drop-down list, add a switch to the Existing Switches 
list by clicking the Add button.

3 Repeat step 2 for each switch that you want to configure.

4 When you have finished configuring the switches, click OK to save the new settings.
-or-
Click Cancel to exit without saving.

Adding and Modifying Tiered Switch Connections
If the switch you want is not in the Existing Switches drop-down list, you can add a switch to 
the Existing Switches list as follows:

1 Click the Add button. The Add Tiered Switch dialog box appears.

2 Type the name of the switch and select the switch type from the list.

3 Click OK to add the switch. The switch should now be in the Existing Switches list and in 
the Switch drop-down list.

Viewing Remote Console Switch Version Information
When you select the Version category for the first time, the MP will retrieve the firmware 
versions from the selected Remote Console Switch.
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Figure 4-11. Firmware Version Dialog Box

Hardware Subcategory
The Hardware sub-category displays the version information for the Remote Console Switch.

 NOTE: To ensure that the full functionality of the Remote Console Software is available to you, please 
ensure that your Boot version is 4.0.0.0 or higher.

SIPs Subcategory
The SIPs sub-category allows you to view version information and upgrade all of the SIPs in the 
system. In addition, in the SIPs subcategory, you can reset SIPs that are connected to tiered 
switches.

For information about upgrading SIPs, see “Upgrading Firmware” on page 73.
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 Figure 4-12. SIPs Dialog Box 2161DS-2 Console Switch

 NOTE: The Vendor field, and Reset SIP button are not displayed when managing Avocent A1000R and 
A2000R Remote Console Switches.

Resetting a SIP
On occasions when a tiered switch is not recognized by the Remote Console Switch, it may be 
necessary to reset the SIP which connects the tiered switch to the Remote Console Switch. This 
can be done using the Reset SIP button in the SIPs subcategory.

 NOTE: PS/2 and USB SIPs are available. In addition the Remote Console Switch is compatible with all 
Avocent AVRIQs including Sun and serial AVRIQs.

 NOTE: The Reset SIPs button is only enabled when the SIP type is PS/2 and when a firmware upgrade is 
not in progress.

 NOTE: The Reset SIP button is not displayed when managing Avocent A1000R and A2000R Remote 
Console Switches.

 NOTE: This procedure is only relevant where your Remote Console Switch system involves a PS/2 SIP 
attached to a tiered switch. On these occasions, it may be necessary to reset the SIP when the tiered 
switch is not recognized.

 NOTE: If a reset is performed, when a Remote Console Switch is connected directly to a server and not 
a Cascade Switch, the mouse/keyboard may fail to respond. When this occurs, the target server requires 
a reboot.
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To reset a SIP:

1 Select the SIPs subcategory from the Versions category in the left hand column in the MP.

2 Select the SIP you want to reset from the ID list.

3 Click Reset. A message appears warning you that this function is reserved for tiered 
switches and that resetting the SIP may result in the need to reboot the server.

4 Click Yes to continue.
-or-
Click No to return to the SIPs subcategory.

Upgrading Firmware
You can upgrade the firmware for either the Remote Console Switch or the SIPs. The SIPs can 
be upgraded individually or simultaneously. When an upgrade is initiated, you will see a progress 
bar. As long as an upgrade is in progress, you cannot initiate another.

The Enable Auto-Upgrade for All SIPs check box allows you to enable an auto-upgrade for SIP 
firmware. You can override the auto-upgrade at any stage using the Load Firmware button 
described in the next section.

 NOTE: For the 2161DS-2 and 4161DS, you can upload new appliance firmware using ASMP (if supported) 
or TFTP file transfer protocols. ASMP file transfer allows you to select the firmware from a local file 
system. The 2161DS and Avocent A1000R and A2000R support the TFTP file transfer allows you to specify 
the TFTP server address and the name of the firmware file.

To upgrade Remote Console Switch firmware:

1 Click the Tools tab in the MP. The Tools dialog box appears.

2 Click the Upgrade Remote Console Switch Firmware button.

If you have made changes in the Settings panel of the MP, but have not yet applied them 
before starting an upgrade, a warning message prompts you to confirm the upgrade 
because the upgrade process requires an appliance reboot. If you do not apply the pending 
changes, they will be discarded before upgrading the firmware.

To apply those changes before the upgrade:

a Click No to cancel the appliance firmware upgrade.

b Click Apply.

c Click the Upgrade Remote Console Switch Firmware button.
-or- 
To discard those changes before the upgrade, click Yes.
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 d The Firmware Upgrade dialog box appears. Select TFTP Server as the source, and 

type the Trivial File Transfer Protocol (TFTP) server IP address where the firmware is 
located as well as the filename and directory location.
or
Click File System and browse to the location on your file system where the FLASH file 
is located. Click Open.

Figure 4-13. Upgrade Firmware Dialog Box- TFTP Server

Figure 4-14. Upgrade Firmware Dialog Box - File System

3 Click the Upgrade button. The Upgrade button dims and a progress message appears.

4 When the upgrade is complete, a message prompting you to confirm a reboot appears. The 
new firmware will not be used until the switch reboots. Click Yes to reboot the Remote 
Console Switch. The Upgrade Firmware dialog box will display a progress message 
including a message that the reboot is complete. 
-or-
Click No to reboot at a later time. You will need to reboot in order to use the new firmware.

5 Click Close to exit the Upgrade Firmware window.

 NOTICE: Do not power down the Remote Console Switch while it is upgrading.

You can upgrade firmware for all SIPs of a given type.
74 Managing Your Remote Console Switch



To simultaneously upgrade multiple SIPs:

1 Click the Tools tab in the MP. The Tools dialog box appears.

2 Click the Upgrade SIP Firmware button. The Upgrade SIP Firmware dialog box appears.

3 Click the check box in front of each type (PS/2,USB, Serial, or Sun) of SIP you wish to 
upgrade.

4 Click Upgrade. The Upgrade button dims. The Status column will display either In 
Progress or Succeeded, depending on the status of each SIP upgrade. A firmware upgrade 
currently in progress message displays until all of the selected SIP types are upgraded.

5 When complete, a message appears prompting you to confirm the upgrade completion. 
Once confirmed, the Upgrade button is again enabled.

6 Click Close to exit the Upgrade Firmware window.

To upgrade SIP firmware individually:

1 Click the Settings tab in the MP.

2 Select the SIPs sub-category under Versions in the left column in the MP.

3 Click the ID drop-down list and choose a SIP for which you wish to view firmware 
information. The IDs displayed in the drop-down list are a combination of the EID and 
either the server name or switch name, depending on what is attached to the SIP. If the SIP 
is not attached to anything, the drop-down list will display None. Once selected, the 
firmware information appears in the Information box.

4 Compare the current information to the Firmware Available field to see the firmware 
upgrade available for the SIP. (You can load firmware even if the current and available 
versions are the same. In some cases, you can downgrade the SIP to an older, compatible 
version.)

5 Click the Load Firmware button.

6 The firmware upgrade begins. During the upgrade, a progress message is displayed below 
the Firmware Available box and the Load Firmware button will dim. When the upgrade is 
finished, a message appears indicating that the upgrade was successful.

7 Repeat steps 2-6 for each individual SIP you wish to upgrade.

8 When finished, click OK.

Controlling User Status
You may view and disconnect the current active user connections using the Status tab in the MP. 
You can view the length of time users have been connected, the server name or SIP to which 
they are connected and their system address. In addition to disconnecting a user session, the 
Remote Console Switch software also allows one user to take control of a server currently being 
used by another user. For more information, see “Preemption” on page 43.
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 Figure 4-15. User Status Dialog Box

To disconnect a user session:

1 Click the Status tab in the MP. The User Status dialog box appears.

2 Click one or more users that you wish to disconnect.

3 Click the Disconnect Session button. A message appears prompting you to confirm the 
disconnect command.

4 Click Yes to disconnect the user.
-or-
Click No to exit without completing the disconnect command.

 NOTE: The appropriate level of access is required to disconnect a user.

Rebooting Your System
You can reboot the Remote Console Switch through the Tools tab in the MP. When clicked, 
Reboot will broadcast a disconnect message to any active users, then log out the current user 
and immediately reboot the Remote Console Switch.

To reboot your system:

1 Click the Tools tab in the MP. The Tools dialog box appears.

2 Click the Reboot button. A message prompting you to confirm this reboot appears. Click 
Yes to confirm the request. The Remote Console Switch will now reboot.
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Managing Remote Console Switch Configuration Files
Configuration files contain all of the settings for a Remote Console Switch. This includes 
network settings, SIP configurations, SNMP settings and attached servers. You may save your 
configuration file and, should you ever need to replace your Remote Console Switch, you can 
restore the configuration file to the new switch and avoid manually configuring it.

 NOTE: User account information is stored in the user database, not in the configuration file. For more 
information, see “Managing User Databases” on page 78.

To read and save a configuration file from a Remote Console Switch:

1 Click the Tools tab in the MP. The Tools dialog box appears.

2 Click the Save Remote Console Switch Configuration button. The Save Remote Console 
Switch Configuration dialog box appears.

3 Click Browse and navigate to a location to save the Configuration file. The location 
appears in the Save To field.

4 Click Save. The Enter Password window opens.

5 Enter a password in the Password field, then repeat the password in the Verify Password 
field. This password is requested when you restore this database to a Remote Console 
Switch. Click OK. The configuration file is read from the Remote Console Switch and 
saved to the desired location. A progress window displays.

6 When complete, a message appears prompting you to confirm the read completion. Click 
OK to return to the main window.

To restore a configuration file to a Remote Console Switch:

1 Click the Tools tab in the MP. The Tools dialog box appears.
2 Click the Restore Remote Console Switch Configuration button. The Restore Remote 

Console Switch Configuration dialog box appears.
3 Click Browse and navigate to the location where you stored the saved configuration file. 

The file name and location appears in the File name field.

4 Click Restore. The Enter Password window opens.

5 Enter the password you created when the configuration database was saved. Click OK. The 
configuration file is written to the Remote Console Switch. A progress window displays.

6 When complete, a message appears prompting you to confirm the write completion. Click 
OK to return to the main window.
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 Managing User Databases

User database files contain all user accounts assigned in a Remote Console Switch. You can save 
your user account database file and use it to configure users on multiple Remote Console 
Switches by writing the user account file to the new switch.

 NOTE: The user account file is encrypted and you will be prompted to create a password when you save 
the file. You will need to re-type this password when you write the file to a new unit.

To save a user database from a Remote Console Switch:

1 Click the Tools tab in the MP. The Tools dialog box appears.
2 Click the Save Remote Console Switch User Database button. The Save Remote Console 

Switch User Database dialog box appears.
3 Click Browse and navigate to a location to save the user database file. The location appears 

in the Save To field.

4 Click Save. The Enter Password window opens.

5 Enter a password in the Password field, then repeat the password in the Verify Password 
field. This password is requested when you restore this database to a Remote Console 
Switch. Click OK. The user database file is read from the Remote Console Switch and 
saved to a location. A progress window displays.

6 When complete, a message appears prompting you to confirm the read completion. Once 
confirmed, the Save Remote Console Switch User Database dialog box will close and you 
are returned to the Tools window.

To restore a user database file to a Remote Console Switch:

1 Click the Tools tab in the MP. The Tools dialog box appears.

2 Click the Restore Remote Console Switch User Database button. The Restore Remote 
Console Switch User Database dialog box appears.

3 Click Browse and navigate to the location where you stored the saved user database file. 
The file name and location appears in the File name field.

4 Click Restore. The Enter Password window opens.

5 Enter the password you created when the user database was saved. Click OK. The user 
database file is written to the Remote Console Switch. A progress window displays.

6 When complete, a message appears prompting you to confirm the write completion. Once 
confirmed, the Restore User Database File dialog box will close and you are returned to the 
Tools window.
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Changing Remote Console Switch Properties
You can alter individual Remote Console Switch properties whether you are logged into the 
switch or not. The Properties dialog box contains several tabs: General, Network, and 
Information. The General tab allows you not only to change the name and display icon for a 
Remote Console Switch but also to assign the switch to a site, location or folder. The Network 
tab allows you to change the IP address for that switch such as if you were to reconfigure your 
network. The Information tab allows you to enter information about the Remote Console 
Switch including a description, contact information and any comments you might wish to add.

To change Remote Console Switch properties:

1 Select an individual Remote Console Switch from the Unit Selector list.

2 Select View - Properties from the Explorer menu.
-or-
Click the Properties button.
-or-
Right-click on the switch and select Properties from the pop-up list. The Properties dialog 
box appears.

Figure 4-16. Remote Console Switch General Properties

3 Type the name of the Remote Console Switch. Duplicate names are not allowed.

4 Ignore the Type field. This is read-only for Remote Console Switches.

5 Select the icon to display for the unit.

6 (Optional) Select the site, department and location to which you wish the Remote 
Console Switch assigned. If the selection you wish is not in the drop-down list, type the 
name of the new assignment in the text field. Once entered, the option becomes available 
in the drop-down list for future assignment.
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 7 Click the Network tab and type in the address of the Remote Console Switch. This field 

can contain an IP dot notation or a domain name. Duplicate addresses are not allowed and 
the field cannot be left blank. You can enter up to 128 characters.

8 (Optional) Click the Information tab and type the description of the unit. You can enter 
any information in the following fields.

a In the Description field, enter 0 to 128 characters.

b In the Contact field, enter 0 to 128 characters.

c In the Contact Phone Number field, enter 0 to 64 characters.

d In the Comments field, enter 0 to 256 characters.You are free to enter any information 
you wish into these fields.

9 When finished, click OK to save the new settings.
-or-
Click Cancel to exit without saving.

Changing DirectDraw Support 
(Windows Operating Systems Only)
The Remote Console Switch Software supports DirectDraw, a standard that allows direct 
manipulation of video display memory, hardware overlays and page flipping without the 
intervention of the Graphical Device Interface (GDI). This can result in smoother animation 
and improvement in the performance of display-intensive software.

However, if your machine has a software cursor or pointer shadow enabled, or if your video driver 
does not support DirectDraw, you may experience a flicker in your mouse cursor when over the 
title bar of the Viewer.

You can disable the software cursor or pointer shadow, load a new driver for your video card, or 
you can disable DirectDraw.
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Figure 4-17. Options Dialog Box - DirectDraw

To disable DirectDraw:

1 Select Tools - Options. The Options dialog box appears.

2 Click to disable the DirectDraw check box.

3 Click OK.

 NOTE: The DirectDraw check box will only appear for Windows based Operating Systems.
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A

Appendix A: Updating the Remote Console 
Switch Software
For optimal operation of your system, ensure that you have the latest version of the Remote 
Console Switch Software available from Dell™ support website at support.dell.com.

To update the Remote Console Switch Software:

1 Download the update file from the Dell support website - support.dell.com.

2 Double-click on the installer. The installer will check to see if a previous version of the 
Remote Console Switch Software resides on your system.

3 If no previous version has been detected and a dialog box appears to confirm the upgrade, 
click Continue.
-or-
If a previous version is detected and a dialog box appears alerting you to another version of 
the product, click Overwrite to confirm the upgrade.
-or-
Click Cancel to exit without upgrading the software. 

4 Installation commences. Program Files, Shortcuts, Environment Variables, and Registry 
Entries (Windows 32 systems only), will be installed or overwritten with the new files and 
settings of the current version.

 NOTE: In order for the upgrade detection process to work, you must first either reboot or log out. Registry 
keys set by the installer are not permanent on Windows 32 platforms or Linux until you have logged out or 
rebooted the system.
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Appendix B: Keyboard and Mouse Shortcuts
Table B-1. Divider Pane Keyboard and Mouse Shortcuts

Operation Description

F6 Navigates between the split-screens and gives focus to the last element that had 
focus.

F8 Gives focus to the divider.

Left or Up Arrow Moves the divider left if the divider has the focus.

Right or Down Arrow Moves the divider right if the divider has the focus.

Home Gives the right pane of the split-screen all of the area (left pane disappears) if the 
divider has the focus.

End Gives the left pane of the split-screen all of the area (right pane disappears) if the 
divider has the focus.

Click + Mouse Drag Moves the divider left or right.

Table B-2. Tree View Control Keyboard and Mouse Shortcuts

Operation Description

Mouse Single-Click Deselects the existing selection and selects the node the mouse pointer is over.

Mouse Double-Click Toggles the expand/collapse state of an expandable node (a node that has 
children). Does nothing on a leaf node (a node that does not have children).

Up Arrow Deselects the existing selection and selects the next node above the current focus 
point.

Down Arrow Deselects the existing selection and selects the next node below the current focus 
point.

Spacebar Alternately selects/deselects the node that currently has the focus.

Enter Alternately collapses/expands the node that has focus. Only applies to nodes that 
have children. Does nothing if the node does not have children.

Home Deselects the existing selection and selects the root node.

End Deselects the existing selection and selects the last node displayed in the tree.
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Table B-3. Keyboard and Mouse Operations for the Unit List

Operation Description

Enter or Return Launches the default action for the selected unit. 

Up Arrow Deselects current selection and moves selection up one row.

Down Arrow Deselects current selection and moves selection down one row.

Page Up Deselects current selection and scrolls up one page then selects the first item on the 
page.

Page Down Deselects current selection and scrolls down one page then selects the last item on 
the page.

Delete Performs the Delete function. Works the same as the Edit->Delete menu function. 
Please see that section for more information.

Ctrl + Home Moves the focus and the selection to the first row in the table.

Ctrl + End Moves the focus and the selection to the last row in the table.

Shift + Up Arrow Extends selection up one row.

Shift + Down 
Arrow

Extends selection down one row.

Shift + Page Up Extends selection up one page.

Shift + Page Down Extends selection down one page.

Shift + Mouse 
Click

Deselects any existing selection and selects the range of rows between the current 
focus point and the row the mouse pointer is over when the mouse is clicked.

Ctrl + Mouse Click Toggles the selection state of the row the mouse pointer is over without affecting 
the selection state of any other row.

Mouse double-click Launches the default action for the selected unit.
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Appendix C: Ports Used by Console Switch 
Software
Table C-1 lists the port numbers that the software uses to communicate with the Remote 
Console Switches. This information can be used to configure firewalls to let the Remote 
Console Switch Software operate in the networks.

Table C-1: Ports Used by Remote Console Switches

Figure C-1. TCP Port Communication

 NOTE: The TCP/IP ports are fixed and cannot be altered.

Port Number Appliance Type Purpose

3211 4161DS, 2161DS-2, 2161DS, 
A1000R or A2000R

TCP Proprietary Management Protocol

3211 4161DS, 2161DS-2, 2161DS, 
A1000R or A2000R

UDP Proproprietary Install and Discovery Protocol

2068 4161DS, 2161DS-2, 2161DS, 
A1000R or A2000R

TCP Encrypted Keyboard and Mouse Data

2068 4161DS or 2161DS-2 TCP Digitized Video Data

8192 2161DS, A1000R or A2000R TCP Digitized Video Data
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